
In This Issue: WWDC News, iPhone 3G S, Macbook Updates
This month’s news is dominated by the announcements made by Apple at the Worldwide 
Developers Conference (WWDC) that took place during the week of June 8, plus the release on 
June 19 of the iPhone 3G S and its corresponding 3.0 operating system.
The major announcements from the WWDC included the new iPhone 3G S, more details about the 
next Mac OS dubbed Snow Leopard, the release of Safari 4, and updates to the line of Macbook 
laptops. Although rumors abounded about a potential Mac Netbook, none was announced. The 
rumors, however, continue, as some people have noticed features in Snow Leopard that could still 
offer hints that a Mac Netbook may be in the works.
You’ll find a compilation of all of these items in this month’s newsletter. Don’t forget to check the list 
of “Hot Links” that take you to even more information available on the Internet.
Also this month, I am experimenting with a redesign of the newsletter, including rearranging some 
pages and using different fonts. Please send any comments to me at ronheck@comcast.net.
Ron Heck, Publications Director

Calendar
To the right is a list of mini’app’les 
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information was compiled as this 
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confirm the Special Interest Group 
(SIG) date, time, and location with the 
SIG Leader or the mini’app’les 
website: www.miniapples.org.
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Meeting Locations and Leaders

 Meeting  Location  Leader
 FileMaker Pro SIG  Partners, 2250 Terminal Rd, Roseville  Steve Wilmes, 651-458-1513

 iWork/AppleWorks
 SIG

 Penn Lake Library, 8800 Penn Ave. S., Bloomington  John Hunkins Sr, 651-457-8949

 Mac OS X SIG  The Foundation, 311 7th Ave N, Minneapolis  Bob Demeules, 763-559-1124
 Mac Q&A SIG  Merriam Park Library, 1831 Marshall Ave, St Paul  Les Anderson, 651-735-3953

 Macintosh
 Consultants SIG

 Good Day Café, 5410 Wayzata Blvd, Golden Valley  Bob Demeules, 763-559-1124

 VectorWorks SIG*  CJR Office, 4441 Claremore Dr, Edina  Charles Radloff, 952-941-1667
* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.

Meeting Calendar – July 2009Meeting Calendar – July 2009Meeting Calendar – July 2009
Wednesday July 1 6:30 pm iWork/AppleWorks SIG

Tuesday July 7 7:00 pm Mac OS X SIG
Wednesday July 8 7:00 pm VectorWorks SIG*

Thursday July 16 7:00 am Macintosh Consultants SIG
Thursday July 23 7:00 pm FileMaker Pro SIG
Monday July 27 7:00 pm Mac Q&A SIG

Website: http://www.miniapples.org Forums: http://miniapples.77.forumer.com Email: miniapples@mac.com
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Submissions
We welcome newsletter submissions from 
members. Perhaps you’re using new software 
that you just can’t live without. Maybe you 
have a new piece of hardware that you find 
extremely useful and of high quality. On the 
other hand, you might be struggling with 
problematic software or hardware.
Why not share your experience with other 
members by writing a product review? Doing 
so may steer others towards quality products or 
help them avoid the problems you may be 
having.
You can E-mail your submissions to 
ronheck@comcast.com. Submissions must be 
received by the 15th day of each month to be 
included in the next month’s newsletter. I am 
happy to help clean up any articles submitted 
for publication in this newsletter.

SIG Reports
If you don’t see a report from your favorite 
Special Interest Group (SIG) in this issue of the 
newsletter, please take a few minutes to provide 
a summary of the next meeting for the next 
newsletter.
Hopefully, understanding what material and 
what level of material is being discussed at the 
different SIG meetings will encourage more 
people to attend SIG meetings and to join the 
mini’app’les.
Thanks for your help.
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iWork/AppleWorks SIG of June 2009
by Harry Lienke

Once again a small group of 
attendees met at the Penn Lake 
Library to discuss and learn about 
iWork and AppleWorks. We still 
need to have more people attend 
these meetings. Please let us know what we 
need to do to make the meetings more attractive 
so you will not be able to spend the first 
Wednesday evening of the month anywhere 
other than the iWork/AppleWorks SIG meeting. 
Do we need to change the meeting night, time, 
or location? If so, what day, time, and/or 
location would convince you to be part of the 
SIG meetings? What topics interest you? What 
level of information are you in need of? What 
format do you think we should be using? What 
other things could be done to entice you to 
come to a meeting? Please let us know what 
you think. You can contact us via telephone 
(651-457-6026), email (miniapples@mac.com or 
plienke@aol.com), or the mini’app’les forums 
(http://miniapples.7.forumer.com).
To start the meeting, John Hunkins, our Special 
Interest Group (SIG) leader told us he has two 
very old Macs needing a new home. One is an 
original Mac and the other is almost that old. 
They are perfect fixer-uppers for a discerning 
collector. Contact John if you would like either 
or both of these classic machines.
President Bruce Thompson pointed out the new 
Board of Directors (BOD) held its first meeting 
on Monday. He thanked John Hunkins and Bert 
Persson for being the election committee 
verifying and counting the ballots.
John next provided us with an interesting 
learning experience. He wanted some business 
cards to encourage people to support his efforts 
in the Bike MS:Star Tribune The Ride Across 
Minnesota (TRAM). He brought with him files 
containing a business card template (see 
Figure 1), a bike license plate scanned into a 
graphic (he bought the license plate on-line), 
and his personal information.

JOHN
HUNKINS SR
Job Title

address
Work Street
Work City, Work State Work ZIP

tel	 Work Phone
fax	 Work Fax Phone
email	 Work Email
url	 Work URL

Figure 1. Business Card Template

The template had two text boxes — one 
containing John’s name and the words “Job 
Title” and the other with the rest of the text. In 
the upper text box, our SIG facilitator, Pam 
Lienke, used the Text Inspector’s Text Tab to 
move the text to the top of the box, used the 
Format>Font>Capitalization>Title sequence 
from the Pages menu to change from all capital 
letters to title case, and used the Center Text 
button on the Format Bar to center justify John’s 
name. Pam deleted the “Job Title” text and 
resized the text box and positioned it near the 
top of the card. Pam inserted the license plate 
graphic using Insert>Choose from the Pages 
menu and selecting the graphic; she then re-
sized the graphic and centered it between the 
two text boxes. Since the Pages document 
containing John’s personal information was 
already open, Pam used Command-~ 
(Command-tilde) to cycle through the open 
documents to that personal information; she 
selected all the personal information 
(Command-a), copied the information 
(Command-c), went back to the business card 
(Command-~), selected all the information in 
the second text box (Command-a), and pasted 
John’s personal information (Command-v) in 
place of the template data. Pam adjusted the 
text in the second text box, sized the box, and 
positioned the text boxes and graphic with the 
Alignment Guides to produce the business card 
shown in Figure 2.
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6872 Blackhawk Trail
Inver Grove Hts., MN 55077

651-457-8949
polkapedaler@gmail.com

Since 1992, rider of the MS 
Societyʼs The Ride Across 

Minnesota (TRAM)
To pledge online, go to 

mstram.com and click on 
Donate/ePledge

John C. Hunkins, Sr.

Figure 2. Finished Business Card

As we were working on the business card, some 
of the text had a red dotted line under it 
indicating a misspelling; someone asked about 
it. Pam used Edit>Spelling to show that “Check 
Spelling As You Type” was enabled. Pam 
indicated that commonly used words can be 
added to the custom dictionary and showed 
how Control-clicking on a word brings up a 
menu that can be used to add that word to the 
dictionary.
Bruce Thompson asked about using Pages to 
make mailing labels. We looked at using the 
Link Inspector’s Merge tab to choose Merge 
Fields to add to the document. It was pointed 
out, however, that each mailing label occupies 
one page so this is not a practical solution. Bob 
Demeules suggested Address Book had been 
changed to handle production of mailing labels.
Pam opened Address Book, selected a Group, 
and selected File>Print from the Address Book 
menu. From the Style pop-up menu, she 
selected Mailing Labels (if the Print dialog 
doesn’t contain the Style Menu and instead 
contains two pop-up menus and buttons across 
the bottom, click the disclosure triangle beside 
the Printer pop-up menu). Experimenting with 
the options on the Print dialog showed many 
different label varieties are built in.
Pam expressed her fondness for Full Screen 
mode when she is working on a document in 
Pages. She likes to change the background color 
from the default black. She showed the location 

of the menu and the different scrolling 
capabilities.
Pam showed how the dictionary or thesaurus 
can be accessed with the Control-Command-d 
key combination. Bob Demeules pointed out 
this can be done from many applications.
Pam demonstrated creating a Character Style to 
change the color of text to red. In response to a 
question about revealing the Styles Drawer, she 
indicated it can be selected from the View menu 
on the Tool Bar or by clicking on the Paragraph 
Mark button at the left end of the Format Bar.
The next iWork/AppleWorks meeting will be 
held at the Penn Lake Library, 8800 Penn Ave. S. 
The meeting will commence on July 1, 2009, at 
6:30 pm and will conclude about 8:00 pm.

OS X Meeting of June 2, 2009
by Bruce Thompson

SIG Leader Bob Demeules 
announced that the OS X SIG 
will meet in July, since it is not 
in conflict with Independence 
Day. He then moved on to recent 
announcements from Apple. Leopard 10.5.7 has 
been released, fixing over 300 bugs, although 
there don’t seem to be any other significant 
changes. Also, Safari 4 (beta) has been updated, 
but you need to update to 10.5.7 before you can 
update Safari 4. There was also a “silent 
update” of the Macbook, with slightly increased 
speed and larger drive.
Bob mentioned the Developers’ Conference and 
the speculation about what would be 
announced. Most speculation has been on the 
iPhone and software. It is anticipated to have a 
faster connection and better GPS capability. 
Also mentioned is the possibility (probability?) 
of a new iPhone v3.
Bob then moved on to a demonstration of the 
“Get Info” command. If you hold down the 
Option key (⌥) while pressing Command-i (or 
selecting the menu item “Get Info”), you bring 
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up the File Inspector rather than just the Info 
window. If you select another file, the Inspector 
window then shows the particulars about that 
file. One of the things that is not used much but 
could be helpful is putting key words into the 
“Spotlight Comments” window in the Info 
window. This can be very helpful for searching.
There was a brief discussion of a couple of 
software bundles available at reduced cost. 
MacUpdate has a bundle worth over $500 for 
$49.95. They typically do this once or twice a 
year. A couple of the programs are worth more 
than that by themselves, so it was felt to be a 
very good value.
Bob then showed the capabilities of Back To My 
Mac, a remote file sharing option available to 
users of MobileMe (previously known as 
“.Mac”). This allows you to connect to another 
computer remotely, using the MobileMe site as 
the go-between. Both computers must be 
running OSX 10.5.7 and registered with 
MobileMe. You can connect to the other 
computer and log in just as you would with any 
networked computer.
Finally, Bob got into a discussion of how Time 
Machine stores its backups. By using something 
called File System Events, Time Machine can 
keep track of what has changed since the last 
backup. Then, by doing an incremental backup 
and using symbolic links to create the illusion of 
a full backup, it is able to work quickly and 
efficiently. Bob again emphasized the 
importance of backups and how Time Machine 
makes it easy.

mini’app’les Directors Meeting Minutes for 
June 1, 2009

In attendance:  Bruce Thompson, Tim Drenk, 
Dave Lundin, Harry Lienke, Ron Heck, Les 
Anderson
Absent:  Kevin Strysik, Tom Gates
Other attendees:  Tim Tierney, Don Walz, 
Chuck Hauge
Agenda:  Adopted as distributed.
Minutes:  The minutes for the April 6, 2009, 
Board of Directors (BOD) meeting were 
approved electronically and published on 
forumer.com on April 13.
Directors’ Reports
Treasurer Dave Lundin’s report:  Don Walz 
reported all bills are paid through April. A 
written report was distributed showing 
transactions through April. Dave provided 
cookies. A suggestion was made to update the 
report format to eliminate unneeded categories. 
A motion to approve the report was made, 
seconded, and passed (MSP).
President Bruce Thompson’s report:  The 
election went pretty well. Some folks couldn’t 
follow instructions and had their ballots 
invalidated. In the future we may want to send 
out the ballot separately from the newsletter to 
emphasize the importance of the ballot.
Publications Director Ron Heck’s report:  Ron 
is trying to keep up on news through RSS feeds. 
In his editorial column he is asking for 
submissions from club members. A suggestion 
was made to rearrange the newsletter to put the 
schedule and the board page in the back of the 
newsletter; news from the BOD and local 
articles with graphics to pique the interest of 
readers should be put in the front. Ron agreed 
to try new formats; he was encouraged by other 
BOD members to make some changes that look 
good to him and see what reactions arise from 
club members.
Membership Director Les Anderson’s report:   
He accessed the club’s iDisk to look at 
membership files. Chuck Hauge reported we 
had ten new and renewing members in the 
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April/May time period; there were ten drops in 
that same period. It was suggested the Renewal 
Notice needs to be updated to be more 
pertinent and to more closely resemble the 
forms contained in the newsletter and the 
brochure. Bruce indicated Erik Knopp is looking 
to pass his coordinator responsibilities on to 
someone else; Les will talk to him.
Old Business
Election Results — The results were posted on 
forumer.com and included in the newsletter. 
Fourteen ballots were cast; one ballot was 
disqualified for lack of a membership number. 
Eleven ballots were cast electronically and three 
were delivered in hard copy form. Thompson, 
Drenk, Lundin, Anderson, and Strysik were 
elected with twelve votes; Lienke and Heck 
were elected with eleven votes.
Terrorist Insurance Rejection Form — Bruce 
filled out the waiver and sent it in; a copy of the 
form was given to Dave.
SWOT Analysis — Chuck Hauge sent out a 
draft document to the committee (Tim Drenk, 
Tim Tierney, and Bruce); Tierney offered 
suggestions for improving the document. 
Chuck needs responses from the rest of the 
committee. It was asked how to get member 
responses to a twenty question survey. It could 
be slimmed down but that would make it less 
useful. Offering an incentive was suggested. 
Perhaps the material could be presented at SIGs 
and time provided for the surveys to be filled 
out. Chuck and the committee will have the 
document, delivery method, and incentive(s) 
defined by the next BOD meeting.
Annual Meeting Follow-up — Dave Peck 
provided no response. This item is being 
dropped.
Status of iBook Sale — We received no bids. It 
was suggested we put it on eBay or Craig’s List. 
A motion for Bruce to put the iBook on Craig’s 
List for $125 and entertain reasonable offers was 
MSP.
Bylaws update — Harry has withdrawn his 
suggested changes.

Web Site Update — Dave Peck has turned 
control of the web site over to Tim Tierney. Tim 
is two months behind in the conversion of the 
web site to iWeb for various reasons including 
many computer problems which are now partly 
fixed. Bruce pointed out the need to move old 
newsletter files from Homepage to our new 
MobileMe account; Bruce and Tim will 
coordinate this effort.
Newsletter Archive — Bruce has received no 
reply from Ken Slingsby so far. This will be 
dropped.
Cartridge World discounts — Tom Gates 
provided no response. This item is being 
dropped.
Budget for 09/10 — Dave and Don provided a 
straw horse. Suggestions were made to provide 
last year’s expenses, adjust projected 
discretionary expenses, and ensure the income 
level was reasonably accurate.
Paypal / Electronic Payment — Dave described 
the twenty page Paypal account agreement. It is 
not easy to understand. Dave was requested to 
further review possible club use of Paypal.
New Business

No new business.
Next meeting:  Scheduled for August 3, 2009, at 
the Merriam Park Library at 7:00 pm. All club 
members are welcome to attend.
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Apple Previews Snow Leopard 
for September Release
by TidBITS Staff

Apple announced last year that 
Mac OS X 10.6 Snow Leopard 
would have under-the-hood 
improvements, but wouldn't 
include a bunch of new features 
aside from support for Microsoft 
Exchange Server (for the primary 
rundown on features, see “Mac 
OS X Snow Leopard to Focus on 
Performance, Not 
Features,”2009-06-08). Until now, 
however, details have been 
sparse. Today, Apple showed off 
Snow Leopard's speed and 
improved performance, as well as some minor 
feature updates. The company also revealed 
Snow Leopard will ship in September and cost 
$29 to upgrade from Leopard. Snow Leopard 
works with any Intel-based Mac with 1 GB of 
memory, at least 5 GB of free disk space, and a 
DVD drive.
Safari 4, Shipping Today -- One piece of 
Apple's Snow Leopard engineering effort is 
making its appearance today. Safari 4, available 
since February 2009 as a public beta, boasts 
impressive speed gains in JavaScript and 
HTML rendering speed. It also has new features 
such as Top Sites and a Cover Flow browsing 
mode (for more detail, see “Apple Releases Beta 
of Safari 4,” 2009-02-24). Safari 4 passed the 
Acid3 standards compliance test with a score of 
100 out of 100, compared to Internet Explorer 8's 
score of 21 out of 100.
One new detail is “crash resistance” when 
running under Snow Leopard: if a plug-in 
crashes in Safari, the rest of the browser session 
will continue to be usable. Apple claims that 
plug-ins are the number one cause of Web 
browser crashes.
Another interesting change from the beta 
version of Safari 4 is that tabbed windows 
behave the same as in Safari 3: the tabs appear 
below the address bar, instead of at the top of 
the window. Apple must have received enough 

negative feedback on the new tab placement 
that it scrapped that feature.
Safari 4 is available for Leopard via Software 
Update. You can also download it as a 
standalone installer for Leopard (43 MB), for 
Tiger (29 MB), and for Windows XP/Vista (47 
MB).
QuickTime X -- Also making its debut in Snow 
Leopard is the latest version of QuickTime, 
which has been completely overhauled, 
boasting ColorSync and hardware acceleration 
support. The update also enhances HTTP 
streaming, enabling QuickTime streaming from 
any Web server, which means the player 
software takes more responsibility for 
managing the connection. (With a streaming 
server, the player and server can communicate 
with each other; with plain HTTP, the player 
sends a request and then has to deal with the 
stream that is dealt to it.) Previous versions of 
QuickTime require special Web server 
modifications for best results.
Additionally, the QuickTime Player, long 
overdue for a user interface refresh, has been 
updated and is now visually similar to the 
iTunes video player. Finally, you can now trim 
clips and share videos to MobileMe directly 
from within the application.
Other Notable Features -- Apple claims that 
Snow Leopard will have over 100 new features. 
While Safari 4 and QuickTime X are among the 
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most significant, there remain a handful of other 
notables. The Finder has been rewritten in 
Cocoa for better performance, but the interface 
remains essentially the same. A new Services 
menu simplifies the technology for sharing 
applications' functionality, and gives hope that 
people may actually use the feature in the 
future.
Expose is now built into the Dock: clicking and 
holding an application icon displays all of that 
program's open windows. Stacks in the Dock 
can now access deeper levels, enabling users to 
see files within subfolders. The contents of a 
Stacks window can also be scrolled, making it 
easier to view all items. And one particularly 
cool feature is the capability to draw Chinese 
characters on a MacBook Pro's trackpad with 
your fingers!
iChat has been made more robust and provides 
higher resolution while using less bandwidth. 
Video chats at 640 by 480 pixels now require 300 
Kbps instead of 900 Kbps. iChat Theater, which 
lets you share a screen remotely for a 
presentation or other purpose, works at 640 by 
480 pixels as well. Apple also claims that iChat 
is more reliable, working around more router 
bottlenecks than the Leopard version. This 
would be welcome, since we've switched almost 
entirely to Skype for audio chats, due to iChat's 
flakiness and problems with audio quality.
For file sharing, Snow Leopard combined with 
at least some models of the AirPort Extreme 
Base Station and Time Capsule will let a 
computer enter a sleep-like mode yet continue 
to share files and media. That's a fascinating 
option, and at long last provides an affirmative 
answer to a question we receive frequently from 
readers about file sharing - can I share files 
when my server is asleep?
Owners of MacBooks and MacBook Pros that 
support multi-touch gestures but which weren't 
granted 3- and 4-finger gestures in Leopard will 
gain them with Snow Leopard. That's a nice 
extra, although one suspects it was added to 
reduce compatibility problems in supporting 
older laptops.

And lastly, iCal gains a persistent inspector 
window, eliminating the truly awful interface in 
the Leopard version of iCal that requires much 
extra clicking to edit events.
Performance Enhancements -- The lack of 
major new features in Snow Leopard can be 
attributed to the work that Apple is putting into 
improving the operating system's performance. 
We're not talking about a tweak here and there - 
Apple is laying a lot of technology foundations 
in Snow Leopard for the future.
To handle all the capabilities that Snow Leopard 
offers, Apple has approached performance from 
multiple directions. All of Apple's major 
applications have been updated for 64-bit 
support, and Apple has also developed a way to 
use the multiple cores in all current Macs and 
multiple processors with multiple cores in the 
Mac Pro and Xserve more efficiently. The Grand 
Central Dispatch method enables any software 
to spread computational load. Currently, most 
programs have to be written so that specific 
features use multiple cores, and that's typically 
a reasonable allocation of development time 
only for gaming, scientific, and video and image 
editing applications.
Apple has long supported threading, a 
programming technique that divides tasks in an 
application into dependent tasks that can run 
simultaneously across multiple cores and 
processors. A thread is almost like a sub-
program, and can operate simultaneously and 
independently from other threads and 
programs. But threading isn't necessarily 
efficient by itself. An application programmer 
has to write code that manages threads properly 
for optimum performance, which isn't always 
easy.
Apple's approach pushes threads down a level 
into something that the operating system itself 
manages. This allows a developer to focus on 
the tasks that a program performs, and to hand 
off thread management to Mac OS X. By having 
the operating system manage threads, tasks are 
not only better managed with many programs 
running, but usage can be better split among all 
available cores. The less waste in using 
processor cycles, the faster tasks can complete.
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All this translates to faster speed on common 
operations such as viewing images and PDFs in 
Preview. A specific example of speed 
enhancements would be that moving messages 
in Mail is, according to Apple, 2.3 times faster, 
and searching within Mail is 1.9 times faster.
Developers must update their programs to 
support Grand Central Dispatch. For existing 
complex programs, that may take a while, 
because such programs already have threading 
built in. Developers will also need to maintain 
Leopard updates and performance for some 
time, even with Snow Leopard's cheap upgrade 
price. Programmers who never used threading, 
however, may adopt it and enable the option 
only within Snow Leopard.
Snow Leopard's installation has been designed 
to be 45-percent faster than Leopard's 
installation process, and recovers over 6 GB of 
space after completed. While this saved disk 
space seems like a minor issue when 1 TB hard 
drives cost $80, less space taken up means more 
efficient code. And it lets Apple talk about how 
much less bloated Snow Leopard is than 
Windows Vista or even the upcoming Windows 
7 - even though there's no possible Apples-to-
Apples comparison. Besides, for users trying to 
make do with a 120 GB drive on the MacBook 
Air, every little bit counts. Finally, since the 
iPhone also relies on OS X, the space savings are 
undoubtedly even more welcome on that 
hardware platform.
On the Snow Leopard “Refinements” page, 
Apple also mentions that Time Machine 
backups to Time Capsule will be up to 50 
percent faster, and the initial backup will be 
much faster as well. This makes perfect sense, 
because Time Capsule's raw network 
performance is far faster for AFP file transfers 
than for Time Machine backups. Time Machine 
writes millions of tiny files; by optimizing the 
interaction with Time Capsule, it's clear that a 
big speed boost is possible.
Snow Leopard Server -- Although it wasn't 
mentioned at the WWDC keynote, Apple also 
announced Mac OS X Server Snow Leopard, 
which will also ship in September 2009, but at a 

price of $499 for an unlimited client version 
(down from $999 for Leopard Server).
New in Snow Leopard Server, presumably 
along with all the changes in Snow Leopard, 
will be Podcast Producer 2, which helps 
automate the creation and publishing of 
podcasts, and Mobile Access Server, which 
makes it easier for Mac and iPhone users to 
access secured network services.
Other improvements include Wiki Server 2, a 
new Address Book Server for shared contacts, 
iCal Server 2, a new Mail Server engine with 
push email support, QuickTime X HTTP Live 
Streaming, NetRestore for easy custom image 
restores over the network, and the iPhone 
Configuration Utility for configuration of 
multiple iPhones with enterprise settings.
Pricing and Release Dates -- As previously 
announced, Snow Leopard requires an Intel 
processor, which cuts the cord for anyone with a 
PowerPC-based Mac. The memory and storage 
requirements are quite compact: 1 GB of RAM 
and 5 GB of available storage space.
Snow Leopard will ship in September 2009 (a 
near-final version for developers is available 
today) and cost $29 for a single license and $49 
for a family pack supporting up to five users 
(for more thoughts on those prices see “Why 
Snow Leopard Should Be (Almost) Free,” 
2009-04-21).
Apple's updated Technical Specifications page 
for Snow Leopard says that Leopard users will 
need a simple upgrade disc, but Tiger users will 
have to purchase a full Mac Box Set with Snow 
Leopard, iLife '09, and iWork '09. Pricing for the 
Tiger update wasn't discussed, but the current 
Leopard Mac Box Set costs $169. (Leopard costs 
$129 and both iLife '09 and iWork cost $79 when 
sold separately.)
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iPhone 3GS Sells One Million 
Units in Its First Weekend
by Doug McLean 

Apple has announced that one 
million iPhone 3GS units were sold 
during the phone's first three days 
of availability. Interestingly, this is 
the exact amount of time it took 
the iPhone 3G, released on 11-
Jul-08, to clear one million units. 
The iPhone 3GS also launched in 
just eight countries, compared to 
24 countries for the iPhone 3G 
launch. Despite the incredible 
anticipation and memorable 
images of lines spilling out of 
Apple retail stores, the original 
iPhone didn't hit the one million 
mark until 74 days after its release on 29-Jun-07.
Although it's interesting to compare these 
numbers, we have to take a number of factors 
into account, especially when considering the 
time it took the original iPhone to hit the one 
million mark. While the subsidized prices for 
the iPhone 3G 8 GB and 16 GB models were the 
same as for the iPhone 3GS 16 GB and 32 GB 
models - $199 and $299 respectively - the 
original iPhone's 4 GB and 8 GB models were 
priced at $499 and $599 (without subsidies). 
Selling at roughly double the cost and under 
first-generation scrutiny and skepticism, the 
original iPhone's 74-day wait to sell one million 
units is easily understandable.
It's also worth considering that since the 
original iPhone's debut, Apple has opened more 
retail stores, and a wider population has caught 
on to the iPhone phenomenon and even the 
concept of owning a smartphone. Additional 
years of marketing, positive reviews, and 
awards should also be acknowledged when 
considering the tremendous reduction in time it 
took both the iPhone 3G and 3GS to hit the one 
million milestone.
But how should we think about the apparently 
identical sales statistic for the iPhone 3G and 
iPhone 3GS? Some factors point to lowered 
expectations, such as the dour economy (the 
major bank failures that signaled the most 

serious phase of the economic crisis 
came after the release of the iPhone 
3G in July 2008). Plus, at least in 
the United States, AT&T's fumbling 
of the iPhone 3GS upgrade pricing 
must have caused some people to 
hold off on upgrading (see “Call 
AT&T for the Best iPhone Upgrade 
Price”, 2009-06-15, and “AT&T 
Improves and Clarifies iPhone 
Upgrade Eligibility”, 2009-06-17). 
While AT&T eventually improved 
its wayward upgrade policy to be 
more friendly to loyal customers, 
initial reporting may still have 
negatively affected the first 
weekend of sales.
On the opposite end of the 

spectrum, the iPhone 3GS could have exceeded 
the sales of its predecessor, given the additional 
year of marketing and press, and an improved 
list of specs for the same price points. This 
year's model also had the benefit of online pre-
orders, with devices shipped free for arrival or 
available for pickup at an Apple Store on launch 
day. The iPhone 3G required in-person sales 
and activation at the beginning of its run.
Which generation's one-million-sold mark is the 
greater accomplishment is thus a difficult 
question to answer - but quite the enjoyable 
problem to have if you're Apple. Meanwhile, 
the demographics of who partook in this first 
weekend's shopping spree will likely remain 
unknown, though this year it likely contained a 
slew of generation-jumping owners of the 
original iPhone, a healthy dash of iPhone 3G 
upgraders, and likely some wide-eyed 
newcomers too.
Permanent article URL: http://db.tidbits.com/article/10369
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iPhone 3GS Review
By Jason Chen

What's the point in buying a new iPhone if it 
looks exactly like the old one? Because once you 
start using it, the speed of the iPhone 3GS will 
amaze you.

There's a reason why Apple called this the 
iPhone 3GS for Speed and not the 3GC for 
“compass” or 3GV for “video recording.” Speed 
is the central upgrade here, and probably is the 
single biggest reason you would upgrade to a 
3GS from a 3G. And if you're coming in as a 
virgin iPhone user, there's definitely no 
question: The 3GS is worth an extra $100.
That declaration may be weird to most of us 
since we usually look for features, and not 
specs, when we're evaluating phones—and 
iPhone 3GS doesn't blow us out in the feature 
department. Instead, it's like getting a bigger TV 
or a faster car. Your old machine works just fine, 
but once you've tried the new one for a week, 
you'll never want to go back, even if it costs you 
a little extra.
Like we said, from the outside the 3GS is 
exactly the same as the 3G. It's slightly heavier 
and has glossy text on the back, but if Steve Jobs 
whipped one out in public before it was 
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announced, you wouldn't have been able to tell 
the difference.
By holding the 3GS next to the 3G, you'll notice 
that the screen is slightly more reflective 
because of the new fingerprint resistant 
oleophobic coating. It even has a little bit of a 
rainbow effect if you reflect a monitor with it. 
Surprisingly, the coating actually works in 
preventing a good deal of fingerprints and face 
grease, and it allows the phone to still be 
smooth and usable even if there are fingerprints 
on the surface.

The shot above illustrates the fact. The two 
phones may look similar in how much finger 
and face grease are on the screen, but the iPhone 
3GS is still usable and doesn't have the problem 
of “sticking” in certain areas that are slightly 
greasier. It's also easier to clean just by wiping 
on your shirt. The glass treatment won't 
eliminate smudging from your bodily secretions 
altogether, but it's a very useful improvement 
for something you're touching all the time.

The 3GS display is ever-so-slightly warmer 
than the 3G's, having a yellow/orangish tint 
when viewed side by side. If you remember, the 
3G's screen was also warmer than the 2G's. It's 
not distracting in any way, and the warm screen 
is slightly easier on your eyes even if the 
brightness is bumped up high.
The video really shows how fast the iPhone 3GS 
is. Safari, Email, Camera all load noticeably 
faster than on the iPhone 3G (both running 3.0 
software). Even booting the phone takes about 
half the time. Apps with long load times, like 
Sims 3, Oregon Trail or Metal Gear Touch all 
show how much faster you get up and running 
on the new device. Seriously, everything is 
faster. It's exactly the same experience as 
switching from a two- or three-year-old 
computer to something brand new. Your apps 
all look the same, but they load and run much 
more smoothly. Even if you're doing the same 
things on both machines, the new machine is 
that much better to work on.
What does this speed increase mean for future 
iPhone apps and games? With the iPhone 3GS 
running on a 600MHz CPU with 256MB RAM 
(up from 400MHz and 128MB), there's a much 
higher performance ceiling for apps to hit. The 
OpenGL ES 2.0 graphics standard that's now 
supported paves the way for an impressive 
visual boost. Hubert (a former Nvidia 
developer) from Ubergizmo says it's somewhere 
along the lines of going from Half Life 1 to Half 
Life 2, which is essentially going up a console 
generation. Gamers should pay attention.
Like we said before, the iPhone 3G will still run 
most of the games for the near future. That 40 
million unit potential market of iPhone/iPod 
Touch devices is too big to just ignore and put 
out an app just for 3GS phones, so your old 
phone will still be able to keep up. But 
developers are like alcoholics. If you put more 
system resources in front of them, they can't 
help but use all of it just because they can. Also, 
they drink a lot.
Apple hates to emphasize specs in products like 
the iPhone 3GS, but even they couldn't resist 
bragging about the speed boost. That S is there 
for a reason.
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The 3GS also has a 3-megapixel camera, adding 
auto focus and video recording. You even get an 
interface that lets you tap on a section of the 
screen that you want to focus on and the phone 
will automatically adjust the focus to that point 
in space.

By tapping on the screen and activating the 
auto-everything—not just auto focus but 
improved auto exposure and auto white 
balance—you're gaining the ability to control 
more of what your shots look like. It's most 
obvious in macro shots where the subject is only 
a few inches away (above). Those two photos 
were shot from the exact same distance in the 
exact same lighting. You can also see in the 
gallery below that the 3GS is slightly better in 
low-light conditions (something the 3G was no 
good at), as well as having better overall auto 
white balance.

I wouldn't say it's a mindblowing revolutionary 
step for the iPhone camera, but it's definitely 
more than just shoving in more megapixels and 
leaving it at that.
The video quality, on the other hand, is pretty 
good for a cellphone. Apple claims up to 30 
frames per second, and as this video of an HD 
recording of SNL shows, it comes pretty damn 
close. Even if it's not quite 30FPS at all times, 
the video is smooth as hell. Recording still isn't 
great in low light since it's a physical limitation 
of cameras in general, but at least it's fluid. The 
tap-to-focus (and re-expose) feature also carries 
over to video, which you can use to “aim” your 
camera at a part of the scene.
You'll also want to use the quick trimming 
feature before you upload your videos directly 
to YouTube to cut out the excess at the front and 
back of your clips. The quick trim is just like 
trimming a clip in iMovie, with the yellow 
draggable borders. Apple says that the 3G 
doesn't have video because the old processor 
isn't capable of handling it, and after taking the 
30FPS videos on the 3GS, we can believe that 
they didn't want to settle for just 15FPS videos.

mini’app’les Newsletter — July 2009 Page 13 of 20

http://gizmodo.com/photogallery/iphone3gscombo/1008877961
http://gizmodo.com/photogallery/iphone3gscombo/1008877961
http://gizmodo.com/photogallery/iphone3gscombo/1008877956
http://gizmodo.com/photogallery/iphone3gscombo/1008877956
http://gizmodo.com/photogallery/iphone3gsscreens/1008873044
http://gizmodo.com/photogallery/iphone3gsscreens/1008873044
http://gizmodo.com/photogallery/iphone3gsscreens/1008873034
http://gizmodo.com/photogallery/iphone3gsscreens/1008873034
http://gizmodo.com/photogallery/iphone3gsscreens/1008873029
http://gizmodo.com/photogallery/iphone3gsscreens/1008873029
http://gizmodo.com/photogallery/iphone3gsscreens/1008873024
http://gizmodo.com/photogallery/iphone3gsscreens/1008873024


Data hogs will also be happy about the 
increased 7.2Mbps data speeds the 3GS can 
achieve. We used the Speedtest app in the App 
Store and over multiple days and multiple 
times (early, mid-day and late at night), clocked 
the 3GS at an average of 1568Kbps, whereas the 
3G only measured 1165Kbps. Their uploads 
were relatively equal, at 226Kbps (3GS) and 
209Kbps (3G), but there was a noticeable 
difference in latency with the 3GS pulling ahead 
at 174ms to the 3G's 231ms. Although on 
average the 3GS scored about 50% higher than 
the 3G, occasionally, in individual runs, it could 
have ranged anywhere from twice as fast to 
about the same speeds.
The speed boost for downloads is interesting, 
seeing as AT&T hasn't even begun to really roll 
out their 7.2 HSPA in very many places yet. 

Since we're testing this before the actual 3GS 
release date, we'll see how much loads of 3GS 
users will impact overall speeds, and we'll see 
how fast the 3GS speeds increase once AT&T 
has the infrastructure to support it.
If you're talking practical use scenarios right 
now, the increased network speeds and the 
increased processing speeds help to cut down 
wait times for both the email and Safari and 
whatever other app you use that grabs a bunch 
of data often. Even if you're on Wi-Fi, the fact 
that there's a faster processor on board mean 
that you're going to be done faster than on the 
3G.

The compass app, along with the 
magnetometer, is great at pointing you 
somewhere in the general direction of North. It 
also doesn't matter which way you're holding 
the phone—either parallel or perpendicular to 
the ground—the arrow and numbers will still 
more or less give you a sense of where you're 
facing.
As a bonus, if you hit the “find me” button in 
Google Maps a second time after it's located 
your GPS position, it'll re-orient your map to 
reflect the way you're facing. It would have 
been extremely useful when I was on foot, lost 
in San Francisco trying catch the last train, not 
knowing which way was which since the street 
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signs are so small and the blocks are so large. If 
I had this, I wouldn't have to have gone a block 
in the wrong direction just to figure out I should 
have been heading the other way.
The compass may not sound like a great feature, 
but apps like Layar, an augmented reality 
browser, are now capable of running on the 3GS 
with the help of the magnetometer and GPS.
Nike+ support is something that I've been 
looking forward to for a long time—so much so 
that I even bought an iPod Touch 2G to use it. 
Well, it's here, and it works. The app is exactly 
like the one on the 2G Touch, and enables you 
all the running features you're accustomed to 
using on any other Nike+ device. What's nice 
about using your phone when running is that 
you always have your phone with you, and if 
you have a stereo Bluetooth headset, you'll be 
able to listen to music, run and answer a call if 
need be.

Voice control actually works. As long as you 
know the right commands, like “call” for calling 
someone on your contact list and “dial” if you 
want to dial a number. The accuracy is quite 
high, and the app can recognize what you're 
saying as long as there's not too much 
background noise. It's also fairly smart. If you 
say “call Mike” and you have multiple Mikes in 
your list, the iPhone will say the names of all 
your Mikes and ask you to be more specific.
The song control works, but gets confused 
occasionally because bands have weird names 
that aren't exactly English—they just share the 
same letters. The iPhone kept confusing 
“Phoenix” with “INXS” or “DMX”, for example, 
but managed to actually get commands like 
“pause music”, “who is this song by”, 
“previous track” “what song is playing?”, 
“shuffle” and “play more like this” correct. And 
if you're worried about figuring out what to say 
to control your phone, just activate the Voice 
Control function and watch the screen; 
eventually the command you want will come 
floating by in the background.
What's also surprising about the 3GS is that you 
wouldn't expect battery life to be improved, but 
it is. Apple's figures that measured 
improvement over the 3G in every category 
except 3G calling were more or less what we 
found in our own testing, which means you 
should be able to last the entire day on one 
charge with no problems. Plus, since the phone 
is faster, you'll probably spend less time looking 
up directions or getting to a restaurant's web 
page—which also saves battery.

The iPhone 3GS is not an insignificant step 
forward in the iPhone family. The Nike+ 
support, magnetometer (compass), video 
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recording, voice command, better camera, better 
battery life and faster data network are all 
improvements nobody would call a step 
backwards. But the biggest day-to-day 
improvement over the 3G is undoubtedly the 
increased processing speed, which is why 
Apple called this phone the 3GS (with the S 
standing for super fast) in order to designate 
that it's basically the 3G, but better.
3G users have the unfortunate question of 
asking themselves whether or not they want to 
spend the $399/$499 to upgrade to the 3GS 
right now. If you're eligible to upgrade in July, 
August or September, AT&T's letting you do so 
at the full subsidized $199/$299 price. If not, 
you'll have to wait until your 18 months are up. 
It's definitely a better phone, but AT&T's plan of 
making early adopters wait another six months 
from now until they can get the standard 
$199/$299 price is frustrating, since we'll 
already be halfway into the iPhone 3GS 
lifecycle. And by then, it'll be worth waiting 
until June 2010 for a true revolutionary jump in 
iPhone design, instead of just an evolutionary 
improvement on the 3G.

Our first generation iPhone review verdict was 
to wait. Our iPhone 3G review gave the go-
ahead to finally mount up. The only issue with 
the iPhone 3GS, if you already have the 3G, is 
that it's not all that different of an experience.

Like I said in the Palm Pre review, I'm a bit 
bored of the iPhone look and feel. If you're 
looking for something new, something different 
and something you're not quite familiar with, 
there's the Pre or the MyTouch 3G. But as a 
whole, the iPhone 3GS is the best all-around 
smartphone available. If you're looking for a 
refined, augmented version of what you already 
know, a phone that, not for nothing, runs all the 
tens of thousands of apps on the App Store, 
choose the iPhone 3GS. [Apple]

 It's quite a bit faster than the 3G

 Hardware additions like better camera, 
magnetometer (compass) and fingerprint-
resistant screen are a nice touch

 Same size and shape as the 3G, so your 
accessories will all still work

 Current upgrade pricing for AT&T for most 
iPhone 3G users is steep if you're not eligible

This article is reprinted from Gizmodo.com under the Creative 
Commons license.
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Hot Links of the Month
Compiled by Ron Heck

New MacBook Pro battery life is 
“to die for”, with 15-inch model 
hitting 8 hours
The new battery in the MacBook Pro 
is getting rave reviews for its 
longevity. Edible Apple provides an analysis 
and compares the current battery to previous 
Mac laptop batteries.
http://tinyurl.com/kuftnt

New Macbook Air Review
Macworld has published an in-depth review of 
the new Macbook Air.  A surprising finding is 
that the new high-end model is actually slower 
than the previous high-end Air model.
http://tinyurl.com/l2uxa7

New Ebook Offers Complete iPhoto 
Documentation
A new eBook is said to provide a thorough 
guide for using iPhoto. The author provides an 
overview of his new book at TidBits.com.
http://db.tidbits.com/article/10306

The Complete Guide to iPhone OS 3.0 for 
iPhone and iPod touch
If you are looking for details about the new 
features of iPhone OS 3.0, iLounge.com 
provides a pretty thorough list including lots of 
screen shots that should help you get familiar 
with the new OS.
http://tinyurl.com/cyfzft

The Pre ain’t no iPhone killer, and here’s why
Edible Apple posts a review of the new Palm 
Pre smart phone and compares its features to 
the iPhone. 
http://tinyurl.com/ng6dhf

New study shows iPhone users to be in a class 
by themselves
iPhone users are richer, younger and perhaps 
more productive according to a new study. 
AppleInsider.com discusses the findings at:
http://tinyurl.com/m5qwdg

June 1st New Yorker Cover Drawn Entirely on 
the iPhone
The cover of the June 1st edition of The New 
Yorker magazine was drawn entirely using the 
iPhone. The artist used the “Brushes” app. 
Gizmodo.com describes how it was done.
http://tinyurl.com/pxfnbq

Apple hardware accounted for 12% of all 
mobile app downloads in 2008
Edible Apple discusses a study that found that 
in 6 months of 2008, Apple hardware accounted 
for 12% of all mobile app downloads.
http://tinyurl.com/msoo9f

Find My iPhone works, and it is awesome
A Chicago blogger writes about losing his 
iPhone and relocating it using Apple’s new 
“Find My iPhone” feature.
http://happywaffle.livejournal.com/5890.html

“Take Control of Safari 4” Guides Readers 
Beyond Basic Browsing
Tidbits.com offers a new book about how to 
master Safari 4.
http://db.tidbits.com/article/10345

The Life of Steve Jobs — So Far
Steve Jobs received a liver transplant this 
spring, but he is still expected to return to work 
at Apple this summer. Gizmodo.com publishes 
a chronological view of Steve Jobs’ life so far.
http://tinyurl.com/lxxujx
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of 
volunteers who have generously agreed to help. They are just a phone call or an email away. Please 
call only during the appropriate times, and only if you are a current mini’app’les member and own 
the software in question.

............Apple II / IIGS Software & Hardware
 1, 2
...............................AppleWorks / ClarisWorks
 3, 4

Classic Macs
.............................Cross-Platform File Transfer
 2, 3

FileMaker Pro
iMacs
Intel-Based Macs

.......................................................................iPhoto
 3
iTunes / iMovie

........................................................Mac OS Classic
 3
Mac OS X

................................................Microsoft Excel
 2, 5, 7
...................................................Microsoft Word
 2, 7

.......................................................................MYOB
 5
Networks

...............................................................New Users
 1
PhotoShop

............................................................QuarkXPress
 7
....................................................................Quicken
 5

........................QuickBooks and QuickBooks Pro
 5
.............................................................VectorWorks
 6

1. Les Anderson
 651-735-3953
 anderslc@usfamily.net
 DEW
2. Tom Ostertag
 651-488-9979
 tostertag@usfamily.net
 EW
3. Bruce Thompson
 763-546-1088
 bthompson@Macconnect.com
 EW
4. Pam Lienke
 651-457-6026
 plienke@aol.com
 DEW
5. Ardie Predweshny
 612-978-9774
 
 DEW
6. Charles Radloff
 952-941-1667
 
 D
7. Ron Heck
 651-774-9151
 ronheck@comcast.net
 DEW

D = Days, generally 9 am to 5 pm
E = Evenings, generally 5 pm to 9 pm
W= Weekends, generally 1 pm to 9 pm

Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of 
these volunteers can also be contacted on our forums. We appreciate your cooperation.

mini’app’les needs more volunteers for Members Helping Members — If you are willing to be a 
Members Helping Members volunteer, please send an email message to Membership Director Les 
Anderson or contact him on our forums with your name, telephone number, contact hours, and the 
software and hardware areas you are willing to support.
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mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. Please make your check payable to “mini’app’les”.

Name:     

Company (if mailed to):     

Address:    

City, State, Zip:     

Phone # (home):     

Phone # (work):     

Phone # (cell):     

Occupation (if applicable):     

Membership ID # (if renewal):     

Email:     
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution 
of the newsletter and membership renewal reminders.

   Check if this is a change of address notice

   Check if you want to volunteer

   Check if you want to be added to “Members Helping Members”

   Check if you were referred by a club member (if so, please give member’s name)

Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796

Thank you for your support!

Benefits of mini’app’les Membership

• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting, 
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.

• Access to our Members Helping Members network of professional and advanced users of Apple technologies. 
These members volunteer their time to help other members with software, hardware, and other Apple related 
issues.

• A variety of Mac Special Interest Groups (SIGs) that meet each month.

• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment 
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).

• Participation in drawings for computer hardware, software, and other computer related materials.

• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
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mini’app’les
the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the 
Minnesota Apple Computer Users’ Group Inc., a Minnesota 
non-profit club. The whole newsletter is copyrighted © by 
mini’app’les. Articles may be reproduced in other non-profit 
User Groups’ publications except where specifically copyrighted 
by the author (permission to reproduce these articles must be 
given by the author). Please include the source when reprinting.

The mini’app’les Newsletter is an independent publication not 
affiliated, sponsored, or sanctioned by Apple, Inc. or any other 
computer manufacturer. The opinions, statements, positions, and 
views are those of the author(s) or newsletter staff and are not 
intended to represent the opinions, statements, positions, or 
views of Apple, Inc., or any other computer manufacturer. 
Instead of placing a trademark symbol at every occurrence of a 
trade-marked name, we state we are using the names only in an 
editorial manner, to the benefit of the trademark owner, with no 
intention of infringement of the trademark.

Questions — Members with technical questions should refer 
to the Members Helping Members section or bring their 
questions to an appropriate SIG meeting. Please direct other 
questions to an appropriate board member. 

Dealers — mini’app’les does not endorse specific dealers. The 
club promotes distribution of information that may help 
members identify best buys and service. The club itself does not 
participate in bulk purchases of media, software, hardware, and 
publications. Members may organize such activities on behalf of 
other members.

Newsletter Contributions — We welcome contributions 
from our members. Please send contributions directly to our 
post office box (mini’app’les, PO Box 796, Hopkins MN 55343) 
or email them to miniapples@mac.com, or email them to the 
newsletter editor at ronheck@comcast.net

The deadline for material for the next newsletter is the fifteenth 
of the month. An article will be printed when space permits and, 
if in the opinion of the Newsletter Editor or Publications 
Director, it constitutes material suitable for publication.

This newsletter was produced using Apple’s Pages word 
processor.

Board of Directors
President Bruce Thompson
 763-546-1088
 bthompson@macconnect.com

Vice President Tim Drenk
 952-431-3978
  tim@drenkconsulting.com

Secretary Harry Lienke
 651-457-6026
 plienke@aol.com

Treasurer Dave Lundin
 715-483-3776
 cdlundin@centurytel.net

Membership Director Les Anderson
 651-735-3953
 anderslc@usfamily.net

Publications Director Ron Heck
 651-774-9151
 ronheck@comcast.net

SIG Director Kevin Strysik
 65l-489-4691
 strysik@mac.com

Director at Large Tom Gates
 612-789-1713
 tgates@isd.net

Membership  Erik Knopp
Coordinator
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